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1 Overview 

This software provides the following features: 

⚫ Capture and display images from a web camera connected to a PC. 

⚫ Save the captured video and audio to a file. 

⚫ Play the saved video file. 

⚫ Transfer live images captured from a webcam to this app running on another PC. 

⚫ Receive and display live images transferred from this app running on another PC. 

 

2 Operating environment 

Windows 10, Windows 11 

 

3 Tools used 

This software uses the following NuGet packages to implement functions for capturing and playing camera images, 

capturing and playing audio, and saving and playing video files. 

 Accord.Video.DirectShow (Accord.NET-Framework)  By: Accord.NET 

Used for capturing images from a camera, obtaining camera information, and setting camera settings. 

 Accord.Video.FFMPEG (Accord.NET-Framework)  By: Accord.NET 

Used for saving and playing video files. 

The license terms for Accord.NET-Framework are described in Accord.NET-Framework-license.txt in the 

installation folder. 

 Naudio   By: Mark Heath & Contributors 

Used for audio input from a microphone, audio output to speakers, and saving and playing audio files. 

The NAudio license terms are described in NAudio-license.txt in the installation folder. 

 FFmpeg (Used as an external program if installed) 

Used to combine audio (wav) and video (mp4) files when saving a video, and to separate audio files from video 

files when playing a video. 

 

4 File structure 

When you unzip the archive, the following files will be generated: 

setup.exe    setup program 

VcapStream_Setup.msi   installer 

 

5 Install 

5.1 Installation of the Software 

This software uses .NET Framework 4.7.2, so the necessary files will be downloaded from the .NET Framework 

download site during installation. 

Therefore, when installing, please make sure you are in an environment with an internet connection and run setup.exe 

beforehand. (This does not apply if .NET Framework 4.7.2 is already installed.) 



 

To begin the installation, unzip the software archive and run setup.exe. 

Depending on the PC settings when you run Setup.exe, the warning below may be displayed. 

 

 

In that case, if you click on the "Detailed Information" section, the Run button will appear as shown below. 

 

Click the Run button to launch the installer. 



When the installer starts, the setup wizard window shown below will appear. Follow the instructions to proceed with 

the installation. 

 

 

When you press the "Next" button, the "Select Installation Folder" window shown below will appear. 

 

Once you have selected the installation folder and target users, click the "Next" button to proceed. 

When you proceed, the following window will appear, so click the "Next" button to proceed. 



 

 

At this time, the warning below may be displayed, but click "Yes" to proceed. 

 

Clicking "No" will cancel the installation. 

 

When the installation is complete, the following window will be displayed. Click the "Close" button to finish. 



 

 

A VCapStream shortcut will be created on your desktop as shown below. 

 

 

When registering to the Start menu, a VCapStream shortcut may be placed in All Programs, or a folder called 

GUSUKU may be created and a VCapStream shortcut may be placed in it. 

 

 

Help files are available in Japanese and English as PDF files. 

 Help_en.pdf  English help file 

 Help_ja.pdf  Japanese help file 



A brief program description is provided in the Readme file below. 

 Readme_en.txt  English version 

 Readme_ja.txt  Japanese version 

 

5.2 Installing Ffmpeg 

FFmpeg is not included in this program's installer. 

To install FFmpeg, open a command prompt as an administrator and run the following command: 

 

 winget install --id=Gyan.FFmpeg -e 

 

You must be connected to the Internet when running the above command. 

 

6 Uninstall 

Open the Control Panel and select "Uninstall a Program" if you are viewing by Category, or "Programs and Features" 

if you are viewing by Large or Small icons. 

In the Programs and Features window, select VCapStream from the "Uninstall or change a program" list and 

uninstall it. 

 

 

7 How to start 

Select VCapStream from the All menu in the Windows Start menu and start it. 

If you cannot find VCapStream in the Start menu, it may be in a group called GUSUKU. In that case, launch 

VCapStream in GUSUKU. 

  



 

8 Connection Diagram 

This application has the function of connecting to a webcam, capturing and displaying camera images, and also the function 

of starting a server function while capturing camera images, and streaming the captured images if a client connects. 

The image below shows the connection when capturing and streaming camera images. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The server accepts connections from multiple clients, making it possible for connections like those shown in the diagram 

above for Server PC1. 

A client can connect to a server and become a server at the same time, so it can relay images received from the server and 

send them to another client. 
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9 Screen Description 

When you start VCapStream, the window below will appear. 

 

   The window shown above is explained below. 

 

9.1 Title Bar 

The title bar displays the application title and version number. 

 

Pressing the " - ", "□", or "×" buttons on the right will perform the actions of "minimize", "maximize", or "exit 

application", respectively. 

Click the icon on the left to display the system menu. 

 



 

We will not explain the functions of the system menu as they are standard for Windows. 

9.2 Menu Bar 

The menu bar has three menu groups. 

 

9.2.1 File menu 

The File menu has the following items: 

 

(1). Connect 

The Connect dialog shown below will be displayed, allowing you to connect to the camera or server. 

 



If the "Camera" checkbox is checked, a connection to the camera will be made. 

Select the camera to connect to from the "Camera Device" combo box. 

 

In the example above, when you open the combo box, two cameras are displayed, so you can select the 

camera you want to connect from there. 

When "Use audio input device" is checked, you can capture audio input from the microphone along with 

the image. 

When "Use audio input device" is checked, the "Audio input device" combo box will become selectable, 

so select the microphone device from there. 

 

The input audio will also be available in the server function described below, and can be heard at the 

destination of the stream. 

If you check "Use audio input device", you will also be able to select the "Audio sample rate" combo box. 

 

The default audio sample rate is 16000 Hz, but if you select a value higher than that, the streaming audio 

may be interrupted. 

When the "Server" checkbox is checked, it will connect to a VCapStream running on another PC. 



 

In the example above, we will connect to VCapStream, which is running as a server on the PC with the IP 

address specified in "Host". 

VCapStream running on the PC specified in "Host" must be connected to the camera and "Start Server" 

must be selected from the "Tools" menu. 

The port number in the "Connection" dialog must match the port number for "Listen TCP Port" in the 

"Option Settings" dialog opened from the server's "Tools" menu. 

The server's port number is specified in the "Option Settings" dialog opened from the "Tools" menu. 

The connection destination of the server-side VCapStream can be another VCapStream server. 

(2). Disconnect 

Disconnects from the connected camera or VCapStream server. 

(3). Open Video File 

To play the recorded video file, open the video file (MPEG4 file) in the file selection dialog. 

 

If you did not use FFmpeg to combine and save the video and audio during recording, the video data (mp4) 

and audio data (wav) will be saved as separate files with different extensions. 

Therefore, if there is a file with the same name as the video file but a wav extension, you will be asked if 

you want to use it as the audio data. Selecting OK will allow you to play the video with audio. 

If there is no wav file with the same name as the video file, and FFmpeg is installed, an attempt will be 

made to extract the audio data from the video file and play it. 

If the video file does not contain audio data, it will play without audio. 

(4). Close Video File 

Closes an open video file. 

(5). Exit Application 



Quit the application. 

9.2.2 View Menu 

The "View" menu has the following items: 

 

(1). Mirror 

Reverses the image horizontally. 

(2). Flip Up/Down 

Flips the image upside down. 

(3). Fit Window to Image 

Resize the window to fit the image size. 

(4). Video Property 

Displays the properties dialog for the connected camera. 

 

The properties dialog will vary depending on the camera, below is an example for the Logitech C270 HD 

WebCam. 

 

 



 

9.2.3 Tool menu 

The Tool menu has the following items: 

 

(1). Capture Start 

Starts capturing video from a camera or server. 

(2). Capture Stop 

Stops capturing video from the camera or server. 

(3). Server Start 

Start the video streaming server. 

(4). Server Store 

Stop the video streaming server. 

(5). Video Play 

Starts playing the opened video file. 

(6). Video Pause 

Stops playing an open video file. 

(7). Video Rewind 

Returns the playback position to the beginning of the opened video file. 

(8). Options 

The option setting dialog shown below will be displayed. 

 



 

In the option settings dialog, set the following items. 

⚫ [File] group 

1. Video Save Dir. 

           Set the directory (folder) where you want to save the video files. 

[Ref … ] button, the folder selection dialog shown below will be displayed. You can select the 

desired folder by opening it and pressing the Open button. 

 

2. Video Filename 

    Set the file name when saving the video file. 

    The date and time will be added to the end of the file name you set for the saved file. 

3.Audio File 

  If FFmpeg is installed, this option determines whether to merge audio files into video files. 

   If you check "Use Ffmpeg.exe to combine audio and video files", the audio data will be combined 



with the video file to create a single video file (mp4) with audio. 

   If this checkbox is not checked, or if it is checked but FFmpeg is not installed, the video file and 

audio file will be saved as separate files. 

   In that case, the file names will be the same, but the video file will have the mp4 extension and the 

audio file will have the wav extension. 

4. Max Record Frames 

            Sets the maximum number of frames for a video file to be saved. 

    Recording will stop automatically when the specified number of frames is reached. 

    If the setting value is 0, recording will be performed without frame limit. 

5. Snapshot Save Dir. 

    Set the directory where snapshot images are saved for capture images. 

[Ref … ] button, the folder selection dialog shown below will be displayed. You can select the 

desired folder by opening it and pressing the Open button. 

 

6. Snapshot Filename 

    Set the file name for saving the snapshot image of the captured image. 

    The date and time will be added to the end of the file name you set for the saved file. 

⚫ [Server Setting] group 

1. Listen TCP Port 

Specify the server's listening port number. 

⚫ [Sound] Group 

1. Sound Device 

Select the speaker device for audio output from the combo box. 

 



The combo box displays the currently connected speakers. 

(9). Video Settings 

Open the Video Options dialog shown below. 

 

In the Video Option dialog, set the following items: 

⚫ [Video] Group 

1. Frame Size 

Sets the size of the image captured by the camera. 

  

2. Video Filename 

Set the frame rate for video captured by the camera. 

  

  



 

9.3 Control Area 

The control area contains controls for capturing and playing video files. 

 

 

The control area becomes operational when you connect to a camera or VCapStream server or open a video file. 

 

The control area contains the following controls: 

(1). [Start] button 

Starts capturing from a camera or playing a video file. 

 

(2). [Stop] button 

Stops capturing from the camera or playing a video file. 

 

(3). [Snapshot] button 

Saves a snapshot image of the video being captured from the camera or server in JPEG format. 

 

(4). [Record] button 

Turn on the "Record" button and then press the "Start" button to save the captured image to a video file. 

(OFF state) 

When the "Record" button is on, the background color will turn orange. 

(ON state) 

The video file will be saved in the folder you specified in the options settings. 

(5). [Sound] button 

Switches the audio playback on the speaker ON/OFF. 

(OFF state) 

When the "Sound" button is ON, the background color will turn orange. 

(ON state) 



(6). Audio volume adjustment trackbar 

Adjust the volume of the audio being played. 

 

(7). Video playback position change track bar 

Change the playback position when playing a video. 

Drag the knob or click the mouse button on the track bar to move the playback position of the open video file. 

 

 

9.4 Display Area 

It displays captured images from the camera, received images from the server, and playback images of video files. 

 

 



The image above shows the screen while an image is being captured from the camera. 

If you change the window size, the image size in the display area will be enlarged or reduced to fit the window size. 

 

9.5 Status bar 

The status bar displays various information. 

 

 

 

 

The information displayed in the above image is explained below. 

(1). Image size 

Displays the pixel size of the captured image or video file in width x height format. 

(2). Frame rate 

Displays the frame rate of the captured image or video in fps (frames per second). 

(3). Elapsed time 

The time elapsed since the start of capture or playback 

(4). Frame Counter 

When capturing, the number of frames captured from the start is displayed. 

When playing a video file, the current frame position and total number of frames are displayed. 

 

  

Image size 

Frame rate 

Elapsed time 
Frame Counter 



10 Streaming Formats 

Video and audio are transmitted over a single TCP/IP port. 

10.1 Streaming Sequences 

The sequence for connecting from the client to the server and sending video and audio from the server to the 

client is as follows: 

(The <CR><LF> below represent the line break codes 0x0d and 0x0a in hexadecimal.) 

 

10.2 Incoming requests from clients 

When a client connects to a server, it sends the following receive request to the server and waits for a response: 

 

 GET<CR><LF> 

Server Client 

TCP connection from client to server 

Sending from the client 

GET<CR><LF> 

Response from the server (streaming header) 

HTTP/1.1 200 OK<CR><LF> 

Content-Type: multipert/x-mixed-replace:boundary=—boundary;  

audio_boundary=--audio_boundary;  

image_size=640x480; audio_sample_rate=1600<CR><LF> 

Send from server (image header) 

<CR><LF>--boundary<CR><LF> 

Content-Type: image/jpeg<CR><LF> 

Content-Bcc: B5; Content-Length: 63291<CR><LF><CR><LF> 

Receiving 

images from a 

camera or server 

Receive audio 

from a 

microphone or 

server 

Transmission from the server (image data) 

(JPEG format binary data of the size indicated in Content-Length) 

Sending from the server (image data end) 

<CR><LF> 

Sent from the server (audio header) 

<CR><LF>--audio_boundary<CR><LF> 

Content-Type: audio/raw<CR><LF> 

Content-Bcc: 5D; Content-Length: 3200<CR><LF><CR><LF> 

Transmission from the server (audio data) 

(16-bit mono binary data of the size specified in Content-Length) 

Sending from the server (audio data end) 

<CR><LF> 

： 

： 

Sends from the server until stopped or disconnected 

(The order of image data and audio data is not fixed.) 

； 

： 

Image 

playback 

Audio 

playback 



 

10.3 Streaming Headers 

Upon receiving an incoming request from a client, the server sends the following message to the client: 

・When audio data is included, image size is 640x480, and audio sample rate is 16000Hz. 

(The second line is wrapped for page convenience, but it is actually one line.) 

 

 HTTP/1.1 200 OK<CR><LF> 

 Content-Type: multipert/x-mixed-replace; boundary=--boundary; audio_boundary=--audio_boundary; 

 image_size=640x480; audio_sample_rate=16000<CR><LF> 

  

 ・When the image size is 640x480 without audio data 

(The second line is wrapped for page size, but it is actually one line.) 

 HTTP/1.1 200 OK<CR><LF> 

 Content-Type: multipert/x-mixed-replace; boundary=--boundary; audio_boundary=--audio_boundary; 

   image_size=640x480<CR><LF> 

  

10.4 Image Data 

When the server receives an image from a camera or another server, it sends the image data in the following 

format: 

 

<CR><LF> 

 --boundary<CR><LF> 

 Content-Type: image/jpeg<CR><LF> 

 Content-Bcc: F5; Content-Length: 63291<CR><LF> 

 <CR><LF> 

 Image data (jpeg format data of the size specified by Content-Length is sent in binary format) 

 <CR><LF> 

 

The image data checksum is the F5 part of Content-Bcc: F5, which is the value obtained by XORing the image 

data byte by byte from the beginning to the end. 

 

When the client receives the –boundary line, it determines that this is the start of the image data and continues 

to receive the data that follows in order. After receiving the image data length and checksum, it imports the image 

data after the blank line, calculates the checksum, and if they match, converts the image data into an image and 

imports it. 

 

If the checksum calculation does not match, it is discarded. 

 



 

10.5 Audio Data 

When the server receives audio data from a microphone or another server, it sends the audio data in the following 

format: 

 

 <CR><LF> 

 --audio_boundary<CR><LF> 

 Content-Type: audio/raw<CR><LF> 

 Content-Bcc: B4; Content-Length: 3200<CR><LF> 

 <CR><LF> 

 Audio data (16-bit audio data of the size specified by Content-Length is sent in binary format) 

 <CR><LF> 

  

The audio data checksum is the B4 part of Content-Bcc: B4, which is the value obtained by XORing the audio 

data byte by byte from the beginning to the end. 

 

When the client receives the --audio_boundary line, it determines that this is the start of audio data and receives 

the data that follows in order. After receiving the audio data length and checksum, it takes in the audio data after 

the blank line, calculates the checksum, and if it matches, takes in the audio data. 

 

If the checksum calculation does not match, it discards it as noise. 

 

11 Data Files 

This software can save three types of files: video files, audio files, and snapshot files. 

Each type of file is explained below. 

11.1 Video files 

When you start capturing with the recording button in the control area turned on, the video file will be saved to 

the folder specified in the "Video save folder" option settings. 

Video files are saved in MPEG4 format with the file extension mp4. 

The file name will be in the format "-yyyyMMdd-HHmmss.mp4" appended to the name specified in "Video file 

name." 

Example: (If recording starts at 13:45:30 on February 1, 2026, the result will be as follows.) 

 capture-20160201-134530.mp4 

  

If you have checked "Use FFmpeg.exe to combine audio into video files" in the audio file settings, video files 

will be saved with audio if there is audio input. 

However, saving video files with audio can only be done if FFmpeg is installed in the environment running this 

app and ffmpeg.exe is executable. 



11.2 Audio files 

If FFmpeg is not installed or "Use FFmpeg.exe to combine audio into video file" is not checked, the audio data 

will be saved as a separate file in the same folder as the video file. 

The audio data file will have the same name as the video file, only with the wav extension. 

Example: (If the file name setting is capture and recording started at 1:45:30 PM on February 1, 2026) 

capture-20160201-134530.wav 

  

11.3 Snapshot files 

If you click the Snapshot button in the Control Area while capturing, the snapshot file will be saved in JPEG 

format in the "Snapshot Save Folder" specified in the Options settings, with a .jpg extension. 

The file name will be in the format "-yyyyMMdd-HHmmss.jpg" appended to the name specified in "Snapshot 

File Name". 

Example: (File name setting is snapshot and recording started at 13:45:30 on February 1, 2026) 

snapshot-20160201-134530.jpg 

 

11.4 Storage conditions for video and audio files 

The conditions under which video and audio files are saved are explained below. 

(1). If FFmpeg is not installed. 

The option setting "Use FFmpeg.exe to combine audio into video file" does not have any effect. 

 If you have enabled "Use audio input device" in the connection dialog 

capture-20160201-134530.mp4  video file (no sound) 

capture-20160201-134530.wav  audio file 

 If "Use audio input device" is not enabled in the connection dialog 

capture-20160201-134530.mp4  video file (no sound) 

(2). If FFmpeg is installed: 

If you check "Use FFmpeg.exe to combine audio into video file" in the options settings 

 If you have enabled "Use audio input device" in the connection dialog 

capture-20160201-134530.mp4  Video file with audio 

 If "Use audio input device" is not enabled in the connection dialog 

capture-20160201-134530.mp4  video file (no sound) 

If you do not check the option "Use FFmpeg.exe to combine audio into video file" 

 If you have enabled "Use audio input device" in the connection dialog 

capture-20160201-134530.mp4  video file (no sound) 

capture-20160201-134530.wav  audio file 

 If "Use audio input device" is not enabled in the connection dialog 

capture-20160201-134530.mp4  video file (no sound) 

  



 

12 Configuration file(VCapStream.ini) 

A settings file named VCapStream.ini is automatically generated. 

The VCapStream.ini file attempts to save it in the folder where the application is installed, but if the application is 

installed in a system-protected folder such as "C:¥Program Files" or "C:¥Program Files (x86)", the file cannot be written 

to by the application, so VCapStream.ini is saved in the application settings folder. 

In most cases, it is created in the folder indicated by the following path: 

 

・C:¥ProgramData¥GUSUKU¥VCapStream 

 

The items in VCapStream.ini are explained below. 

[SETTING]       Settings section 

CONNECT_TYPE=0      Destination 0=Camera 1=Server 

CAMERA_NAME=Logi C270 HD WebCam    The name of the last connected camera 

FRAME_WIDTH=640      Frame size (width) 

FRAME_HEIGHT=480      Frame size (vertical) 

FRAME_RATE=15      frame rate (fps) 

AUDIO_INPUT_ENABLE=True     Microphone input availability 

 (True=yes, False=no) 

AUDIO_INPUT_NAME=Microphone (Logi C270 HD WebCam)  Microphone device name 

AUDIO_SAMPLE_RATE=16000    Audio sampling rate 

SERVER_NAME=192.168.1.26     The host name/IP address of the last connected 

server 

SERVER_PORT=8080      TCP port number of the last connected server 

VIDEO_DIR=D:¥Data      Path to the folder where video files are saved 

VIDE_FILE_NAME = Capture     video file name 

REC_FRAME_COUNT=0     Maximum number of frames to save  

(0 = no limit) 

   MERGE_AUDIO_TO_VIDEO=True    Use FFmpeg to merge audio into a video file 

SNAPSHOT_DIR=D:¥Data     Path to the snapshot storage folder 

SNAPSHOT_FILE_NAME=snapshot    Snapshot save file name 

LISTEN_PORT=8080      TCP port number to listen on when the server 

is running 

AUDIO_OUTPUT_NAME=Speaker (USB Speaker)   Audio output (speaker) device name 

 

  



 

13 [Update history] 

Ver.1.00  2026/ 01/13  

・Initial Release 

  Ver.1.01  2026/01/31 

   ・Added a checksum to the transferred data. 

・If FFmpeg is installed, it will launch ffmpeg as an external program to combine the audio and video and  

save them into a single file. 

・Fixed a bug where audio from the server could not be saved to the video file. 

・Added audio input sample rate setting. 

・Added streaming header items (image size, audio sample rate, etc.). 

    Ver.1.02  2026/02/01 

 ・Changed the way to check whether FFmpeg is executable 

 ・Updated the Help file (added installation instructions, data file explanations, and stream data explanations) 
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・Accord.Video.DirectShow Created by: Accord.NET 

 Used for capturing images from the camera, obtaining camera information, camera settings, etc. 

・Accord.Video.FFMPEG Created by: Accord.NET 

 Used for saving and playing video files. 
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15 [Terms of use] 

・Terms of use 

There are no special conditions. Please use it freely. 

However, this does not include use for criminal purposes or harming others. 

・Distribution 

Redistribution is free in unedited or unmodified form. 

・Editing and modification (for source code) 

Modifications and changes are free, but if you redistribute a modified version, you must include documentation clearly 

stating the changes in the distribution. 

This does not apply if part of this software's source code is used in other software. 

・Disclaimer 

  The author assumes no responsibility for any damage or injury resulting from the use of this software. 

The author assumes no obligation to fix or upgrade the software, even if bugs are discovered. 

・Bugs and requests 

  Please report any bugs or requests via email. 

  However, there is no guarantee that bugs will be fixed or requests will be implemented. 

・Copyright information: 

The copyright of this software is held by the author, GUSUKU. 

This software is protected by Japanese Copyright Act and international treaties. 

Use within the scope of the Terms of Use is permitted, but please note that use or distribution in violation of the Terms 

of Use will constitute copyright infringement. 

・Copyright information of the package used 

This software uses the following NuGet packages. 

Copyright information for each package is provided in the license information for each package. 

・Accord.NET Framework ( Accord , Accord.Video , Accord.Video.DirectShow , Accord.Video.FFMPEG ) 

 The license information for this package is available in Accord.NET-Framework-license.txt. 

・Naudio 

 The license information for this package is available in NAudio-license.txt. 

 

16 【contact address】 

GUSUKU 

root@gusuku.org 

[Website] 

https://www.gusuku.org/ 

[Software release site] 

https://www.gusuku.org/software 
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